
GET STARTED USING CUSTOM FORM STUDIO 
 

This guided tour introduces you to Custom Form Studio features.  See also full 
documentation in the HelpDesk for more details about Custom Form Studio and other 
areas of the software. 
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The Custom Form Studio builds your form groups and standard inspection comments 
for the Report Writer and Phone3D.  You can create and customize forms for different 
types of inspections or needs.  In most cases, you can easily streamline or modify 3D 
forms that came with your software or from other vendors, adjusting wording, 
permanently adding and removing items, or changing the order of items.  Note: Certain 
editions of 3D software may not include advanced Custom Form Studio features or the 
Draw Graphical Forms utility. 
 
Custom Form Studio primarily customizes “contents” or form wording, including the 
order and labels for inspection items and their comments. 
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LAUNCH CUSTOM FORM STUDIO 
 
This guide tours main Custom Form Studio features so you’ll be ready to start 
customizing your own forms.  More details about various features covered herein and 
advanced features can be found in the regular Custom Form Studio documentation. 
 
Let’s open the Custom Form Studio: Switch to the Report Writer, and then click 
File > Custom Form Studio. 
 
Note: You may also right-click within any field of an open inspection to quickly launch a 
Customize Inspection Content window for that particular form. 
 
ABOUT FORM GROUPS 
The main Custom Form Studio window displays installed form groups and forms: 

 
 
Form Groups are actually arrangements of several forms (up to 28) joined together for 
final inspections.  Individual forms usually cover single components such as Electrical, 
Plumbing, or Roofing, which are then joined together in a group to create final 
inspections.  This makes it easy to create different groups that share some of the same 
form sections.  For example, the same Roof form might be used in both a single-family 
and multi-unit form group, whereas other forms in those groups may be different. 
 
On the main window, Form Group names are listed in the left column.  Click a Form 
Group to view the Forms In Selected Group, or its main sections, in the center column. 
 
We’ll use the “Residential Checkstyle” forms as an example.  Note: If these forms are 
not included in your edition, you may examine another one that is included instead.  If 
you modified your forms or use other forms, different inspection items may display, but 
the features work the same. 
 
Click one of your Form Groups.  This example shows how Residential Checkstyle 
might display its Forms in Selected Group: 
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Forms in Selected Group are the individual form sections that make up the selected 
group.  Click other Form Groups to see their Forms in Selected Group.  Forms in 
Selected Groups shows the actual user-defined filenames on your hard drive containing 
the form data, often named based on its contents.  When creating new forms, use easily 
identifiable filenames.  The filenames themselves are not printed.  The printed Form 
Description name is actually specified within the form file, as we’ll see. 
 

REARRANGE THE FORMS IN A GROUP 
 
The order of forms in the Report Writer and on final inspection printouts is determined 
by the order of Forms In Selected Group.  Each form in the group has a form button at 
the top of the Report Writer when an inspection is open. 
 
CHANGE THE ORDER OF FORMS 
Changing this order is easy.  When the desired Forms in Selected Group are shown, 
just click and drag the desired form to a new position in the group.  For example, click 
Residential Checkstyle group to display its forms.  Next click on RESIDENTIAL KITC, 
and click and drag it upward to another place in the group, releasing the pointer at the 
new position.  You can rearrange any form in a group the same way.  Unless you want 
the Kitchen form to remain repositioned, right-click and Undo Changes to Group 
immediately to restore the original order.  Or drag to reposition as desired.  (Note: Once 
you select/highlight another group, Undo is no longer available) 
 
REMOVE UNUSED FORMS 
Removing a form from the group is easy.  Just right-click the desired Form in Selected 
Group and choose Remove.  Removing a form from the group does not delete the form 
file itself, but merely removes it from the current group.  Note: If you try this, and don’t 
really want to remove the form from the group, right-click and Undo Changes to Group 
immediately to abort. 
 
ADD NEW FORMS 
Adding an existing form to your group is also easy.  A complete list of all Available 
Forms is shown in the right column.  Available forms may be included or mixed and 
matched in any groups as desired.  To add one to your current group, click and drag the 
desired Available Form into your group, where it will be added to the bottom.  Afterward, 
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click and drag to reposition it.  Note: If you try this, and don’t really want to add the form, 
right-click and Undo Changes to Group immediately to abort, or right-click and remove 
the item. 
 
You can also create a brand new form by right-clicking and choosing Create New Form.  
Once you have assigned a filename, an editing screen appears to add form contents.  
Later, we will discuss the editing screen and how to use its features. 
 
After rearranging the order of your forms, you must Compile them to update the Report 
Writer.  To do so, right-click the group name and choose Compile.  On the Compile 
window, just click Compile.  For details on additional options that are available, click 
Help.  When a group successfully compiles, new inspections created in the Report 
Writer will use your latest compiled changes.  However, existing inspections are not 
affected by changes. 
 

CUSTOMIZE FORM CONTENTS 
 
Now, let’s edit the contents of a form.  From the main Custom Form Studio window, 
click Residential Checkstyle to display its forms.  Let’s examine the Electrical form.  In 
Forms in Selected Group, right-click RESIDENTIAL ELEC and choose Edit Form: 

 

 
 
The Customize Form editor appears: 
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The customize form editor is where you change the “contents” of a form, including the 
printed Form Description (name), Headings and Subheadings (main and sub 
categories), Narratives (standard comments), and other elements in the form structure.  
When first opened, only form main level items are shown, which may be expanded and 
collapsed as needed to view underlying items. 
 
Note the lower pane always shows the item currently highlighted or selected with the 
cursor bar.  This is where content changes are made, as we’ll see later. 
 
FORM DESCRIPTION (PRINTED TITLE) 
Notice the “Form Description” field near the top of the window.  This is the actual title 
printed for this form in your group.  Adjust the label as desired.  
 
ABOUT FORM ITEMS 
Notice that Headings and other form items are organized in the same order as in Report 
Writer.  Some items are nested within main level items.  Use the plus marks in the tree 
to see underlying level items.  Expanded items can be collapsed, so you only view what 
you need at a time. 
 
To see all items in the form at once, click the “Expand Tree” button in the toolbar.  
Do that now. 
 

 
 
The various items were originally added using the Insert menu in the toolbar. 
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Here’s a brief description of main form items: 
 
Headings are labels of main form sections, just as several forms create a form group. 
  
Subheadings are further divisions of a Heading.  Each subheading has a comment 
field in the Report Writer.  Multiple subheadings may be used under each heading.  
 
Narrative 1, 2, 3 items are prewritten comments available, listed below the subheading 
to which they apply.  In the Report Writer, Narratives are selected from the side menu.  
Narrative 2 and 3 items are available only after their higher level Narrative is selected.  
For efficiency and to avoid scrolling through a long list of narratives, it may be a good 
idea to split subheadings with lots of narratives into smaller ones.  For example, a ”Type 
and Condition” subheading might be split into separate “Type” and “Condition” 
subheadings to make completing inspections faster. 
 
Highlight any narrative in your open form, and view its properties in the lower pane.   
The “Abbreviation” displays for quick selection in Report Writer and PDA menus.  Use 
an abbreviation that tells you what the comment is about.  Abbreviations are not printed; 
only the full “Narrative Text” comment imports into inspections. 
 
You may set certain comments be pre-selected for new inspections by ticking “Default” 
in the narrative Properties.  Use this for items that usually apply to all jobs.  Also, 
comments may be pre-set to mark the inspection field for “summary” when selected.  
You may also include “Images” that automatically import with your comment.  See 
program Help, and the FAQ section of this guide for further details. 
 
Text items are standard text or images that ALWAYS automatically print on every 
inspection where specified.  Use this type of item for disclaimers, definitions, general 
information, or other text that always applies to EVERY inspection.  Text items do not 
display in the Report Writer, nor can they be modified once an inspection is created.  
Text items always appear when you preview or print inspections, if their form was used. 
 
Schematics or Diagrams indicate a location and label for an optional sketch area. 
  
These are the most frequently used form items.  Help documentation has more 
information about these and other form items that may be Inserted and their options.  
 
CHANGE ITEM WORDING 
Changing a form item label, comment, or other property is easy.  Just locate and select 
(highlight) the item you want to change in the form tree and then edit its Properties in 
the lower pane. 
 
For example, to change the automatic Text wording that prints at the top of the 
Electrical form, highlight the Text item in the upper portion, then use the lower pane to 
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edit the full text shown.  To change a heading label, such as the Heading “Service” to 
“Main Service” or some other label, simply click the item and make your change in the 
lower Properties pane.  The same is true for Narrative and other form items in the tree.  
For instance, to change the Narrative 1 labeled “[OH] Overhead” to a longer comment 
or adjust its abbreviation, simply highlight it and changes its Properties below.  Go 
ahead and practice making changes here and there.  It’s OK if you don’t want to keep 
them, as we will simply choose not to save when we exit. 
 
However, saving changes when editing a form does not immediately update them in 
Report Writer until they are Compiled, which we’ll review later.  First, let’s learn about 
other form customize features. 
 
ADD NEW ITEMS 
You may easily add new items, such as narrative comments or headings or subheading 
to your forms.  As a rule of thumb, whenever you add or paste items into the form tree, 
always place your cursor bar directly BELOW where you want the items to import.  
Items always import right ABOVE the cursor bar location.  It doesn’t matter if the item 
you highlight is another narrative, heading, subheading, text item, or other item, as long 
as the new item you add will fit properly in the tree structure. 
 
Let’s add a new narrative to the “Service”, “Type & Condition” section (if you renamed 
these categories, select comparable ones).  Type and Condition has narratives for 
Circuit Breakers and Fuses.  Let’s add a new combined “Circuit Breakers and Fuses” 
item.   If we want the item to be located beneath “Fuses” and its sub level items, we 
must highlight the item directly below them.  Therefore, highlight the narrative “[OK] 
Appears Serviceable” and then click Insert > Narrative 1 to add that type of item.  A new 
blank Narrative 1 appears between Fuses and OK: 
 

 
 
Your new item properties are displayed in the lower pane, ready for entry.  Add an 
Abbreviation (Break&Fuse) and Narrative Text (perhaps “Breakers and Fuses”, or “Both 
breakers and fuses are present”) and then click back to the tree at the top when 
finished.  See how easy this is?  You may want to practice adding other types of items 
to your form the same way (positioning your cursor and clicking Insert) since we are not 
planning to save this edit session. 
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CUT, COPY, AND PASTE ITEMS 
Delete, move, or replicate items using Cut, Copy, and Paste tools.  First highlight the 
desired item.  If the item has sub-levels or a plus mark, all lower level items are included 
also.  Your last item cut or copied is saved to a clipboard.  Afterward, to move the items 
to a new location, relocate your cursor and click Paste to insert them above your cursor 
position. 
 
For now, let’s cut the item we just added.  Click the [Break&Fuse] Narrative 1 we added 
in the previous step to select it and then click Cut to remove it.  If you’d like, you can re-
position your cursor elsewhere and click Paste. 
 
Since we are already editing the Electrical form, for the sake of practice, let’s copy the 
“[OH] Overhead” narrative from the Service “Type & Condition” subheading to 
“Grounding Equipment”.  First highlight the [OH] item and then click Copy.  Next locate 
the “Grounding Equipment” subheading.  Remember items always insert “above” the 
cursor bar position.  Let’s make it the first item under that subheading.  So highlight the 
[Plum/Rod] narrative just below the area we want to insert and then click Paste.  The 
program pastes the clipboard contents above our cursor bar. 

 
Now, let’s copy the entire “Grounding Equipment” subheading and its sub-level items to 
a new location.  Highlight the “Grounding Equipment” subheading and Copy.  Let’s 
replicate it to just below the next “Electrical Distribution Panels” heading.  Remember 
we must highlight just below where we want items to paste, so highlight the first “Main 
Panel” subheading.  Now Paste and see how the entire “Grounding Equipment” 
subheading and its narratives are added.  
 

TIPS: 
• To work with several same level items at once, toggle on Multi-select mode.  Tick boxes 

let you select multiple items to cut or copy.  Click Multi-select to turn it on/off as desired. 
 
• To remove a higher level item without removing the sub level items beneath (i.e. 

eliminate a Heading label, but keep its subheadings and narratives, first turn on Multi-
select mode and select all underlying items.  Cut the items, and then Paste them to a 
new location, perhaps above the main item you wish to eliminate. Once underlying items 
have been moved, you can safely Cut the original main level item that is now by itself. 

 
• You can also use Copy and Paste to move specific text “within” an item's Properties, or 

from one items Properties to another.  The program keeps separate clipboards for 
moving tree items verses editing within the lower properties area of items, although the 
same Edit options are used for both areas. 

 
We don’t want to save our practice changes, so let’s exit without saving.  Click 
Cancel.  That way the form remain unchanged from the last time it was saved.  
You can abort changes this way if you edit in error.  To keep changes, you’d choose 
Save and Exit.  As you edit forms you may also want to periodically use Save to update 
changes and continue working, especially when doing a lot of work. 
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USING & EDITING SUBFORMS 
A great way to replicate identical form sections is using Subforms.  This feature is ideal 
for duplicating or sharing larger sections amongst various forms, or to repeat an entire 
form an additional time in the same group. 
 
Insert > Subform is used to add or select new subform sections in a form.  Subforms 
import their data into your main form at the location specified when the group is 
compiled.  Whenever the contents of the subform changes, it updates all areas where it 
is used when those forms are compiled.  To edit the contents of an existing subform, 
highlight the subform and click the Edit button in the lower pane properties. 
 

TIPS:  
♦ Keep in mind that you also can copy headings or subheadings on the fly in the Report 

Writer or Phone3D to replicate components, so we recommend including only the 
minimal number of items you are likely to encounter during an inspection, whether 
repeated using subforms or Copy and Paste. 

 
♦ If you want to copy a section and then modify it for a similar but different component, use 

Copy and Paste to create an independent section.  However, if the replicated items 
should always match everywhere they are used, use a subform.  Subform items are 
always edited from the original subform file itself, and simply import their information into 
form areas where used, automatically updating all areas at once at compile time. 

 
♦ If the items to replicate are already in your main form, and you want to convert the 

section into a subform, you might Cut them from the main form, then Insert a new 
subform, and Paste them there. 

 
Subform Example 
Let’s consider an example of subform usage.  In the Residential Checkstyle Group, 
several forms use subforms to replicate individual interior areas.  For example, the 
Bathrooms form uses them to repeat individual bathroom sections, since the same 
items apply to each bathroom.  Rather than Copy the bath areas, a Subform was used.  
An advantage is that changes made to the subform automatically will affect ALL areas 
where it was used (i.e. all bathrooms), since it’s sharing the same subform data. 
 
Let’s examine the design.  From the main Custom Form Studio window, click 
Residential Checkstyle to display the Forms in Selected Group.  To examine the 
main bathroom form, right click the RESIDENTIAL BATH form and Edit Form: 
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The form edit window appears: 

 
 
Do you notice anything unusual about this form?  Instead of subheadings and narratives 
listed under the headings for each bathroom area, only “Subform: Res Bath 
Subforrm.CFS” items are listed.  This means that the contents of that separate form file 
gets pulled into this main form in the respective “Subform” locations when the forms are 
compiled for use.  Since the same subform is imported multiple times, the same Res 
Bath Subform.CFS form contents are repeated and shared in each location. 
 
To edit the contents of a Subform, highlight the item and click the Edit button in the 
lower pane. 
  
Let’s do that now.  Highlight one of the Subforms clicked, and click the Edit 
button in the lower pane. 
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Note the subform ONLY contains several subheadings to cover the various bathroom 
component.  No heading is needed in this subform because it is imported into a main 
form under appropriate Headings.  You may Expand items here to see narratives 
beneath them as desired.  Since this subform is imported after each bathroom area 
heading in the main Residential Bath form, this means that all these subheadings and 
their contents gets replicated in every location where this file is included as a subform. 
 
The form description in a file imported as a subform (“Single Bathroom”) is ignored at 
import time, since only the form tree contents “inside” this file is imported into the other 
main form.  The other main form has its own Form Description that is used for that 
entire form section, regardless of what subforms or other items are present within it. 
Any changes made to subform contents will affect all areas where the file is used as a 
subform when forms are compiled.  We learn about compiling next. 
 
When done viewing the contents of the subform, click Cancel to exit the form and 
return to the prior window. 
 
Let’s Cancel out of the main bathroom form as well.  Click Cancel to return to the 
main Custom Form Studio window. 
 
 

UPDATE OR COMPILE FORM CHANGES 
 
Changes you make and save in Custom Form Studio don’t come into use for new 
inspections until you “Compile” them.  When you compile a form group, all changes 
made throughout all the forms and subforms used by that group are updated together. 
 
Let’s compile the Residential Checkstyle forms now.  Right-click the Residential 
Checkstyle group and choose Compile.  If any forms you changed or updated are 
used or shared by other Form Groups, you’d need to compile those groups separately 
in order to update them.  (For information about other group functions or settings such 
as Ratings and Preferences, see Custom Form Studio Help documentation.)  
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The Compile window appears. 

 
 
To just update your form group for the Report Writer, click Compile. 
 
Click Compile and a status log displays as it works. 
 
Each form and subform CFS file is listed as it compiles.  When complete, the log lists 
form statistics and should indicate “Form was compressed to ??% of original size”.  If 
so, then your forms have been successfully updated for new Report Writer inspections 
you create.  Any existing inspections are not affected by new changes compiled into the 
forms.  This protects existing inspections from being modified after delivery to the client. 
 
If you get the message “Errors were detected” at the bottom of the log, then the forms 
were not updated because of something invalid in your form structure.  Use the scroll 
bar to view the error(s), which are listed in the location where they occur.  Write down 
the CFS files above the errors and the errors listed, and see Help for instructions on 
correcting them. 
 
Click Exit when done. 
 
Of course, since we didn’t save any practice changes made during this tour, you likely 
won’t notice any differences in new inspections at this point.  But you are now ready to 
start making your own custom form changes and compiling them for actual use. 
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Although you can get started right away, you will find additional valuable tips by 
reviewing the remainder of this guide.  Further comprehensive information about all 
Custom Form Studio features can also be found in the HelpDesk. 
 
 

FAQS AND OTHER USEFUL TIPS 
 

How Do I Copy Existing Forms? 
It depends on whether you simply want to (a) “share” a form with other groups or you 
want (b) a totally independent form file so changes won’t affect the other file. 
 
(a) Sharing a Form: To “share” a form with other groups, just drag it from “All Available 
Forms” into the desired group.  If you want to “repeat” the form in the same group, then 
you would need to add a brand new form to the group and then insert the existing form 
into it as a subform.  When you edit a particular form file, your changes will update other 
areas where it is used in a group or as a subform.  See also the Custom Form Studio 
Help or documentation topic on “Replicating Form Information”.  
  
(b) Making a Separate Copy of a Form: Making a copy of a form so you have two 
separate unshared files is useful when you want to use your copy as a base for a 
different but similar form.  In this case, you must copy the existing form to a new name.  
In Custom Form Studio, locate the Available Form, then right-click and Copy.  Enter a 
new filename for your separate copied form.  Afterward, locate your new filename in the 
Available forms, right-click and Edit to customize it further.  You also will likely want to 
drag your copied form into the desired Form Group.  (For information on making a copy 
of an entire group, see the next section) 
 
Note: If the form you copy contains Subforms inside it, then for “everything” in the form truly 
separate and independent, you may also need to make copies of the subform files themselves 
and insert the new copied subforms in place of the original ones in your copied main form.  Of 
course, if the subform sections are not going to be different, then you can “share” those pieces 
with the original form if you like, even though other parts of the main form can be independent. 
 
How Do I Copy An Entire Form Group? 
It depends on whether you simply want to (a) rename or copy a group, “sharing” some 
or most of its forms with another group, or whether you want (b) a totally independent 
form group and files so changes made to one group don’t affect the other. 
 
(a) Copying an Existing Group Arrangement: To simply copy a group arrangement to 
another name, but sharing the same form files, right-click the Form Group, choose Copy 
Group, and enter a name for the copy.  Note that both groups share the “same” form 
files, which means changing their contents will affect both groups.  However, the groups 
are separate so you can rearrange their forms in different orders, or remove or add 
forms in one group without affecting the other group arrangement. 
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(b) Creating an Independent Copy of a Group: 
To have totally separate and independent groups, with independent form files (so 
changes made to forms in one group won’t affect the other), you must first make copies 
of each individual form file used within the original group.  See previous section “How 
Do I Copy Existing Forms?”  Once you have separate copies of those forms, you can 
then drag the new copies into a new group.  To create a new group, right click within the 
Form Groups pane and choose Create New Group.  Give your new group a name, and 
then drag your new copied forms from Available Forms into it. 
 
How Do I Make A New Group Of Forms? 
To create a new group, right click within the Form Groups pane and choose Create New 
Group. Give your new group a name.  Afterwards drag Available Forms into your new 
group or right-click the Forms In Selected Group pane and choose to Create New Form. 
 
How Can I Create or Change Ratings used throughout a Form Group? 
To change or add Ratings boxes to a form group, in the main Custom Form Studio 
window, right-click the form group and choose Modify Ratings.  We recommend running 
the Ratings Wizard to adjust the rating labels and other main settings as desired.  See 
Ratings window help for details.  When exiting recompile your forms, and then create a 
new test inspection to make sure your new ratings work and print as expected. 
 
To turn Ratings on/off for particular subheadings, you may right-click the subheadings in 
the Report Writer and enable/disable them as desired.  You may also turn on Ratings 
for subheading properties while editing them in the Custom Form Studio. 
 
How Can I Quickly Locate a Comment in a Form? 
When customizing form contents, use the Find and Find Next toolbar buttons to quickly 
locate a particular phrase or abbreviation.  To find and replace a particular phrase in 
various comments, after using Find to locate the first occurrence of the phrase, make 
your change.  Then highlight the new text in the item properties and click Copy to save it 
to the text clipboard.  When you use Find Next to locate additional instances of the 
original phrase, you can just highlight it and Paste your saved clipboard text to quickly 
replace it.  Repeat for additional areas as needed. 
 
How Do I Change The Level Of A Form Item? 
To change a narrative level, select it and then click the narrative level arrow tools to 
decrease or increase the item.  Be sure items end up in a valid hierarchy so forms can 
compile. 
 
Other form items have different Properties, and so cannot just be changed to anther 
level (e.g. headings to subheadings).  But you can Insert a new item of the appropriate 
level and then Cut the item text or label from the original item and Paste it in the new 
one.  Afterward, you can cut the original item from the form tree or adjust it as desired.  
See prior information about “Cut, Copy, Paste” for more information. 
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Can I Make Items Always Print On My Inspections? 
Yes, there are a couple ways to include standard information you always want printed 
(Note: For header or footer information that prints on every page, see Report Writer 
documentation about Page Setup): 
 
Text items that ALWAYS print on the form when it is used may be added using Insert > 
Text.  Text items cannot be edited or turned off from the Report Writer, so don’t include 
comments that won’t always apply. 
 
Defaults can be used to automatically select or include certain narratives when new 
inspections are started.  These comments are seen in the Report Writer and may be 
removed or changed if they don’t apply to a particular job.  Defaults are frequently used 
for common conditions or building aspects that “usually” apply, eliminating the time that 
would otherwise be used to select them.  Default desired narratives by ticking the 
“Default” box in their lower Properties pane.  Defaulted narratives display red in the 
Custom Form Studio tree for easy locating. 
  
Can I Set Items To Automatically Go To Summary? 
Yes, various narrative comments may be pre-set to go to summary when selected.  
Simply choose the desired Summary status in their Properties in the lower pane. 
 
If set to a particular summary area, when the narrative is selected in the Report Writer, it 
automatically flags the Subheading field or comment for that summary area.   Please 
note that if you are not using Ratings for summary and are using Phone3D or the 
Marked Fields summary method in the main Report Writer (see Summary Area help 
topic there), only one summary area can be set for each inspection comment field, thus 
marking the entire field for the last summary area selected.  If different summary areas 
are pre-set for different narratives in the same subheading, the last one selected 
overrides.  So if you want to use multiple summary areas in a group of narratives, you 
may want to organize them under separate subheadings to create different inspection 
fields that can be marked for different summary areas. 
 
How Come My Changes Don’t Show Up in My Inspections? 
Did you Compile your changes after making them?  Right-click the group in Custom 
Form Studio and Compile as needed.  If you did compile, make sure the log does not 
indicate any errors were detected.  If so, you must correct the errors before the changes 
will update the Report Writer- Help there has details about correcting errors.  Also, 
remember changes only show up for new inspections, not existing ones, so be sure to 
starting a new one to see your changes. 
 
How Do I Customize My Inspection Printouts? 
When start a new inspection directly from the Report Writer, narrative forms with white 
icons generally use the Report Writer Inspection Page Setup, whereas graphical forms 
with a yellow icon have a preset printed format.  
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Inspection Page Setup can be customized for narrative inspection forms using File > 
Page Setup in Report Writer.  Various universal “styles” are set for different form 
elements, which then automatically format reports at print time.  See Page Setup 
documentation in Report Writer. 
 
Graphical Forms that always print as designed in Draw Graphical Forms can only be 
modified in Draw Graphical Forms (not available in all editions).  These typically 
replicate pre-printed forms that are not designed to be changed, such as government or 
other official forms that must look at certain way.  However, if your edition of 3D 
software contains the Draw Graphical Form utility, you could adjust the layout of 
graphical forms or create new ones.  See Draw Graphical Forms documentation in the 
HelpDesk.  Otherwise, you may need to contact the forms vendor if a correction or 
change is needed on a particular graphical form you use. 
 
How Do I Backup, Transfer, Restore, or Install Forms? 
Please see the main Report Writer Help and documentation about backing up all your 
important 3D Inspection System software data files. 
  
However to quickly backup only a particular custom form group and its related files, 
simply right-click the Form Group and choose Backup/Distribute Group.  This method 
would be used to quickly transfer a form group to another computer, user, or inspector.  
Or to quickly backup a form group as it exists before making future major changes. 

 
 
For normal group backup, “Include uncompiled forms in the backup” to make sure all 
source forms, subforms, and other files used by the group are included.  Form 
distributors who do not want to include source forms may choose not to include these 
under certain circumstances—See documentation. 
  
After clicking Backup, assign a name for your backup .3DF file, perhaps indicating date 
or revision information.  Backup additional groups you have customized as well.  Be 
sure to frequently backup and save your 3DF backup files in a safe location off your 
computer for protection.  To transfer forms to another computer, first back them up, 
transfer the backup file, and then install them (see below) on your other computer. 
 
Restoring or Installing New Forms 
You can easily restore or install a .3DF form backup anytime using File > Install a set of 
forms in the Report Writer or Custom Form Studio.  Locate open the .3DF file to install. 
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If some or all of the form files are already installed, you will be warned about overwriting 
existing files.  If you want to backup your current files first, you may cancel the process 
and backup your existing forms to a separate 3DF file as a precaution, before 
overwriting them by installing another backup file.  It may be normal to get the warning 
message if you are installing form groups that share some of the same form files. 
  
How Do I Merge Office Management Data Into My Inspections? 
Where you want Office Management data to merge into inspections, you must include 
special merge fields in your narrative comment or text area.  To do so, while editing 
your comment use Insert > Office Management Field to include various merge fields as 
desired.  These items will automatically import the Office Management information from 
linked jobs when selected. 
 
We also recommend setting those narratives as Defaults so they will automatically 
merge when your inspection is started.  Some forms provided by your vendor may 
already contain narratives with Office Management fields, which may or may not be 
already set as defaults.   See “Can I Set Items to Always Print on My Inspections” FAQ 
above for details.  Don’t forget to compile forms after updating them so changes affect 
future inspections. 
 
See Office Management documentation for more information about automatically 
merging job data into inspections, and how to make sure jobs link so data will import. 
 
For additional information about any Custom Form Studio feature, see the complete 
documentation provided in the HelpDesk. 
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